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5

Working with Page Layout 
and Design in Word

In the previous chapter, you dealt with Word at the “tree” level of 
words, sentences, and paragraphs. But getting more out of Word 
also requires that you deal with the program at the “forest” level of 
pages and documents. This means you need to get familiar with 
Word’s page layout tools.

Page layout refers to how text and paragraphs are laid out on each 
page, and it involves building tables, adding headers and footers, 
setting margin sizes, specifying the page orientation, choosing the 
paper size, and so on. This chapter shows you how to work with 
these and other page layout features.

Building a Table
Most     Word documents consist of text in the form of sentences and 
paragraphs. However, including lists of items in a document is com-
mon, particularly where each item in the list includes two or more 

In this chapter, you learn about creating 
tables to hold structured data, adding head-
ers and footers to your documents, and work-
ing with page layout options such as margins, 
page orientation, and paper size. Topics 
include the following:

 ➔ Inserting a table into a Word document

 ➔ Working with table rows and columns

 ➔ Adding and populating document headers and 
footers

 ➔ Choosing a page orientation and paper size

 ➔ Setting the page margins

 ➔ Adding footnotes and endnotes
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Insert a Table
 Although    Word gives you no less 
than one-half dozen ways to build 
a table, you need to know only the 
most straightforward method.

 1. Position the insertion point where 
you want the table to appear.

 2. Click the Insert tab.

 3. Click Table.

 4. Click Insert Table to display the 
 Insert Table dialog.

details (which means a standard bulleted list won’t do the job). For a short 
list with just a few details, the quickest way to add the list to a document is to 
type each item on its own line and press Tab between each detail. You could 
then add tab stops to the ruler (see Chapter 4, “Working with Text in Word”) 
to line up the subitems into columns.

That works for simple items, but to construct a more complex list in 
Word, you can build a table, a rectangular structure with the following 
characteristics:

 • Each item in the list gets its own horizontal rectangle called a row.

 • Each set of details in the list gets its own vertical rectangle called a column.

 • The rectangle formed by the intersection of a row and a column is called 
a cell, and you use the table cells to hold the data.

In other words, a Word table is similar to an Excel worksheet or an Access 
datasheet.

2

4

3

For a small table, you 
can also click a box that 

represents the number of 
rows and columns you want.

For example, click here 
to insert a table with four 
columns and three rows.

1
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 5. Specify the number of columns 
you want in your table.

 6. Specify the number of rows you 
want in the table.

 7. Click OK. Word inserts the table.

 8. Position the insertion point inside 
a cell and then add the text that 
you want to store in the cell. 
Repeat for the other cells in the 
table.

 9. Click the Layout tab.

 10. Use the Table Column Width box 
to set the width of the column.

Displaying the Ruler
If you don’t see the  ruler, click the 
View tab and then activate the 
Ruler check box.

5 6

7

10 9

You can also set a 
column’s width by 
dragging its Move 

Column Width marker 
in the ruler.

You can also set a column’s width 
by dragging its right border.

8
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Select Table Elements
Before      you can change the layout or formatting of a table, you need to select 
the part of the table you want to work with. Here are the techniques to 
use (note that, in each case, “Layout” refers to the table’s Layout tab, which 
appears to the right of the Table Design tab):

 • Select a cell— Select the cell and then click Layout, Select,  Select Cell (or 
triple-click anywhere in the cell).

 • Select two or more adjacent cells—Select the top-left cell you want to 
include in the selection, then drag the mouse down and to the right to 
include the other cells.

 • Select a row— Click any cell in the row and then click Layout, Select, 
Select  Row.

 • Select two or more adjacent rows—Select at least one cell in each row 
and then click Layout, Select, Select Row.

 • Select a column— Click any cell in the column and then click Layout, 
Select, Select Column.

 • Select two or more adjacent columns—Select at least one cell in each 
column and then click Layout, Select,  Select Column.

 • Select the entire table—Click any cell in the table and then click Layout, 
Select,  Select Table.

>>>Go Further
CONVERTING TEXT TO A TABLE
If       you already have a list where each column is separated by a tab, comma, or 
some other consistent character, you can convert that list to a table. To try this 
out, first click within the list. Click the Insert tab, the Table command, and then 
Convert Text to Table. Word displays  the Convert Text to Table dialog. Adjust the 
Number of Columns and Number of Rows values, if necessary. If you separated 
your columns with a character other than a tab or comma, use the Other text box 
to type the character. Click OK to convert the list to a table.
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Format a Table
To      change the formatting of the table 
cells, you select the cells you want 
to work with and then use Word’s 
standard formatting tools (font, para-
graph, and so on). For more table-
specific formatting, you can use the 
 Table Design tab.

 1. Click inside the table.

 2. Click the Table Design tab.

 3. Click the More button of the Table 
Styles gallery.

 4. Click the style you want to apply 
to the table.

 5. Click Header Row to toggle 
header formatting on and off for 
the first row. For example, in some 
styles the first row is given darker 
shading, top and bottom borders, 
and a bold font.

 6. Click Total Row to toggle total for-
matting on and off for the bottom 
row.

 7. Click Banded Rows to toggle alter-
nating formatting for all the rows.

 8. Click First Column to toggle spe-
cial formatting on and off for the 
first column.

 9. Click Last Column to toggle spe-
cial formatting on and off for the 
last column.

 10. Click Banded Columns to toggle 
alternating formatting for all the 
columns.

If you see the style you want to 
apply, you can click it without 

opening the Table Styles gallery.

1 3

2

4

8 95 10

7 6

9780789754301_BOOK.indb   799780789754301_BOOK.indb   79 9/17/15   11:10 AM9/17/15   11:10 AM



Chapter 5 Working with Page Layout and Design in Word80

 11. Select the cells you want to format 
and then use the Shading gallery to 
click a background color.

 12. Select the cells you want to format 
and then use the Border Styles gal-
lery to click a border style.

Modifying a Table Style
If the  predefined table styles aren’t quite 
what you’re looking for, you can modify 
any style to suit your needs. Apply the 
style that comes closest to what you want, 
right-click (or Control-click) the style in the 
Table Styles gallery, and then click Modify 
Table Style. In the  Modify Style dialog that 
appears, use the controls to adjust the 
style’s fonts, colors, borders, and more.

Insert New Rows
There      are times when you need to add 
more data to a table. Word provides sever-
al tools that enable you to expand a table. 
If you’re adding new items to the table, 
you need to add more rows.

 1. To add a new row at the end of the 
table, position the insertion point in 
the lower-right cell—that is, the last 
column of the last row—and press 
Tab.

 2. Click the Layout tab.

 3. To add a new row above an existing 
row, position the insertion point 
inside the existing row and then 
click Insert Above.

 4. To add a new row below an exist-
ing row, position the insertion 
point inside the existing row and 
then click Insert Below.

1211

1

23

4
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Insert New Columns
If  you     need to add more details to 
each item in your table, you need to 
add more columns.

 1. Click inside an existing column.

 2. Click the Layout tab.

 3. To add a new column to the left 
of an existing column, click Insert 
Left.

 4. To add a new column to the right 
of an existing column, click Insert 
Right.

Inserting Multiple 
Columns
To  insert multiple columns at 
once, first click the same number 
of existing columns. For example, 
if you want to insert two columns 
into your table, click two exist-
ing columns. Click the Layout tab 
and then click either Insert Left or 
Insert Right.

>>>Go Further
INSERTING MULTIPLE ROWS
If you want to insert  multiple rows, you can insert them all in one operation. To 
begin, click the same number of existing rows. For example, if you want to insert 
three rows into your table, click three existing rows. Again, you’ll be inserting the 
new rows either above or below the selection, so click your rows accordingly. 
Click the Layout tab and then click either Insert Above or Insert Below.

3 4 2

1
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Delete Table Elements
If you      no longer need a part of your 
table—for example, a cell, a row, or a col-
umn—you can delete it. You can delete 
multiple cells, rows, or columns, and, if 
necessary, you can delete the entire table.

 1. Select the table element you want 
to delete.

Selecting Elements for Deletion
If you want to delete a row or column, 
you need to click anywhere inside that 
row or column. If you want to delete 
multiple rows or columns, you need 
to select at least one cell in each row 
or column. If you plan on deleting the 
entire table, you need to click anywhere 
inside the table.

>>>Go Further
MERGING TABLE CELLS
 Although       most people use tables to store lists of data, using a table to lay out a page in 
a particular way is also common. For example, if you are building a Word document that 
looks like an existing paper form or invoice, you will almost certainly need to use a table 
to do it. However, on most forms, not all the fields—which will be the cells in the table 
you create—are the same width: You might have a small field for a person’s age, a much 
wider field for an address, and so on. Changing the row width as you learned in the pre-
vious section does not work because you need to change the sizes of individual cells.

The best way to do this is to build your table normally and then merge two or more 
cells together. For example, if you merge two cells that are side by side in the same row, 
you end up with a single cell that is twice the width of the other cells. To merge cells, 
first select the cells. (You can select cells in a single row, a single column, or in multiple 
rows and columns. However, the selection must be a rectangle of adjacent cells.) Click 
the Layout tab (the one to the right of the Table Design tab) and then click Merge Cells.

1
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 2. Click the Layout tab.

 3. Click  Delete.

 4. Click the command that repre-
sents the type of table element 
you want to delete. If you click the 
Delete Cells command, the Delete 
Cells dialog opens.

 5. Click whether you want to shift 
the remaining cells to the left or 
up, or if you would rather delete 
the entire row or column.

 6. Click OK.

3 24

6

5

Working with Headers and Footers
A header         is a section that appears at the top of each page between the top 
margin and the first line of text. Any text, graphics, or properties you insert in 
any header appear at the top of every page in the document. Typical header 
contents include the document title and the date the document was created 
or modified.

A footer is a section that appears at the bottom of each page between the 
bottom margin and the last line of text. As with a header, anything you insert 
in any footer appears at the bottom of every page in the document. Typical 
footer contents include the page number and document filename.

Here are your choices for adding content to a header or footer:

 • Text—You can type any text, such as a brief document description, a 
note to the reader, or your company name.

 • Page numbers—  You can insert just the page number, the phrase Page X 
(where X is the current page number), or Page X of Y (where X is the cur-
rent page number and Y is the total number of pages in the document).
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Adding a Header
You      can create a header from scratch 
by inserting a blank header (with one 
or three columns) or you can click a 
predefined header template.

 1. Click the Insert tab.

 2. Click  Header.

 3. Click the type of header you want 
to add. Word inserts the header 
and displays the Header & Footer 
tab.

 4. If you want to include a page 
number in your header, click Page 
Number.

 5. Click Page Number.

 • The current date and time—  You can display the current date, time, or 
both the date and time using various formats. You can also configure the 
date and time to update automatically each time you open the docu-
ment.

 • Document information—You can insert a number of document proper-
ties, including Author, Comments, Status, Subject, and Title.

 • A field—Choose  Design, Document Info, Field, and then use the Field 
dialog to insert the field code.

 • Picture or clip art—   You can insert a photo or other image from your 
computer or you can grab a piece of online clip art.

1 2 3

4 5
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 6. If you want to include the date or 
time (or both) in your header, click 
Date & Time to open the  Date and 
Time dialog.

 7. Click the format you want to use.

Updating the Date and 
Time Automatically
If you  want Word to update the 
displayed date and time auto-
matically each time you open 
the document, click the Update 
Automatically check box (in the 
Date and Time dialog).

 8. Click OK.

>>>Go Further
CREATING A UNIQUE FIRST-PAGE HEADER
By default,  when you define the content for one header, Word displays the same 
content in every header in the document. However, many situations arise in 
which this default behavior is not what you want. One common situation is when 
you want to use a different header in the first page of a document. For example, 
many texts use no header on the first page. Another example is when you want 
to insert document instructions or notes in the first header, but you do not want 
that text repeated on every page.

For these kinds of situations, you can tell Word that you want the first page’s 
header to be different from the headers and footers in the rest of the document. 
You set this up by clicking the Different First Page check box. Word changes the 
label of the first page header to First Page Header.

6 7

8
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 9. If you want to include a docu-
ment property in your header 
(such as the Author or Title), click 
Field to open the Field dialog.

 10. Click Document Information.

 11. Click the property you want to 
add.

 12. Click OK.

 13. If you want to include an image 
from your computer, click Picture 
from File. See “Inserting a Picture” 
in Chapter 3, “Working with Office 
2016 for Mac Graphics.”

 14. To add text, position the insertion 
point within the header and then 
type your text.

 15. Click Close Header and Footer or 
click the header’s Close tab.

9

13

10 1411

12 15

>>>Go Further
CREATING UNIQUE ODD AND EVEN PAGE 
HEADERS
Many documents require different layouts for the header on odd and even 
pages. A good example is the book you are holding. Notice that the even page 
header has the page number on the far left, followed by the chapter number and 
chapter title, while the odd page header has the name of the current section fol-
lowed by the page number on the far right.

To handle this type of situation, you can configure your document with different 
odd and even page headers and footers by clicking the Different Odd & Even 
Pages check box. Word changes the labels of the page headers to Even Page 
Header and Odd Page Header.
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Adding a Footer
You can     create a footer from scratch 
by inserting a blank footer or you can 
click a predefined footer template.

 1. Click the Insert tab.

 2. Click Footer.

 3. Click the type of footer you want 
to add.

 4. If you want to include a page 
number in your footer, click Page 
Number.

 5. Click Page Number.

 6. If you want to include the date or 
time (or both) in your footer, click 
Date & Time to open the Date and 
Time dialog.

 7. Click the format you want to use.

 8. Click OK.

1 2 3

4 5

6 7

8
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 9. If you want to include a docu-
ment property in your footer, click 
Field to open the Field dialog.

 10. Click Document Information.

 11. Click the property you want to add.

 12. Click OK.

 13. If you want to include an image 
from your computer, click Picture 
from File. See “Inserting a Picture” 
in Chapter 3.

 14. To add text, position the insertion 
point within the footer and then 
type your text.

 15. To switch to the header, click Go to 
Header. When you’re in the header, 
you can switch back to the footer 
by clicking Go to Footer.

 16. Click Close Header and Footer or 
click the footer’s Close tab.

11

141210

9

13

15

Changing the Page Setup
Word’s options and features for setting up pages are legion, but few of us use 
them with any regularity. That’s a shame because Word’s page setup tools are 
often useful and easy to use, after you get to know them. The next few sec-
tions take you through the most useful of Word’s page setup features.

Setting the Margins
One      of the most common page layout changes is to adjust the margins, the 
blank space to the left and right, as well as above and below the document text 
(including the header and footer). The standard margins are 1 inch on all sides. 
Decreasing the margins fits more text on each page (which is useful when 
printing a long document), but it can also make the printout look cluttered and 
uninviting. If you increase the margins, you get less text on each page, but the 
added whitespace can make the document look more appealing.

You can set specific margin sizes for the Top, Bottom, Left, and Right margins, 
and you can also specify where you want Word to apply the new margins: to 
the whole document or from the insertion point forward.

16
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 1. Click the Layout tab.

 2. Click  Margins.

 3. Click Custom Margins. Word 
opens the  Document dialog and 
displays the Margins tab.

 4. Use the Top spin box to set the 
top margin.

 5. Use the Bottom spin box to set 
the bottom margin.

 6. Use the Left spin box to set the 
left margin.

 7. Use the Right spin box to set the 
right margin.

Adding a Gutter
You can  also set the size and posi-
tion of the gutter, which is extra 
whitespace added (usually) to the 
inside margin to handle docu-
ment binding. In the Margins tab 
of the Page Setup dialog, use the 
Gutter spin box to set the size 
of the gutter, and use the Gutter 
Position list to click whether you 
want the gutter in the left margin 
or the top margin.

 8. Use the Apply To list to click 
whether you want your new mar-
gins applied to the whole docu-
ment or only from the insertion 
point forward.

 9. Click OK.

12

If you see the margin size option you 
want to use, you can click it without 

opening the Document dialog.

3

4

5

6 7

8 9
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Changing the Page 
Orientation
By default,       page text runs across the 
short side of the page, and down 
the long side. This is called portrait 
orientation. Alternatively, you can 
configure the text to run across the 
long side of the page and down the 
short side, which is called landscape 
orientation.

 1. Click the Layout tab.

 2. Click  Orientation.

 3. Click the page orientation you 
want to use.

12 3

>>>Go Further
LANDSCAPE VERSUS PORTRAIT
You would use the   landscape orientation mostly when you have text or an image 
that is too wide to fit across the page in portrait orientation. If you’re using letter-
size paper and your margins are set to 0.75 inches, you have only 7 inches of 
usable space across the page. Wide images, a table with many columns, or a long 
line of programming code are just a few of the situations in which this width 
might not be enough. If you switch to landscape, however, the usable space 
grows to 9.5 inches, a substantial increase.
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Changing the Paper Size
Word       assumes that you will be print-
ing your documents on standard 
letter-size paper, which is 8.5 inches 
by 11 inches. If you plan to use a 
different paper size, you need to let 
Word know what you will be using 
so that it can print the document 
correctly.

 1. Click the Layout tab.

 2. Click Size.

 3. Click a paper size.

12 3

>>>Go Further
SETTING A CUSTOM PAPER SIZE
If you need to set a custom paper size, click Format, and then click Document 
to open the  Document dialog. Click Page Setup to open the Page Setup dialog. 
In the Paper Size list, click Manage Custom Sizes, use the Width and Height text 
boxes to set your custom paper width and height, respectively, and then click OK.

>>>Go Further
PRINTING ON THE EDGE
Getting the proper printout isn’t the only reason for configuring Word to use a 
different page size. An old trick is to tell Word you are using a larger paper size 
than you actually are. Word then prints the page as if you’re using the larger size, 
which with some experimentation means you can get Word to print right to (or 
pretty close to) the edge of a regular sheet of paper or an envelope.
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Add a Page Break
If you have      a paragraph that must begin 
at the top of a page, you can ensure that 
happens by inserting a page break just 
before that paragraph.

 1. Click at the beginning of the para-
graph that you want to appear on 
a new page.

 2. Click the Insert tab.

 3. Click Pages.

 4. Click  Page Break.

23

1

4

Understanding Sections
In      Word-related training sessions and question-and-answer periods, some of the 
most common complaints and queries center on using multiple page layouts in 
a single document:

 • How can I have different headers (or footers) for different parts of a document?

 • I have a long table on one page. How can I set up that one page with land-
scape orientation?

 • Can I switch from a two-column layout to a three-column layout for part of 
a document?

Most people end up splitting a single document into multiple documents to 
accomplish these and similar tasks. However, you do not have to break up your 
document just because you want to break up the page layout. The secret to 
doing this is the section, a document part that stores page layout options such 
as the following:

 • Margins

 • Page size and page orientation

 • Headers and footers

 • Columns

 • Line numbering

 • Footnotes and endnotes
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Add a Section Break
When you create a document, Word 
gives it a single section that com-
prises the entire document. However, 
you are free to create multiple sec-
tions within a single document, and 
you can then apply separate page 
layout formatting to each section. 
The transition from one section to 
another is called a section break.

 1. Click where you want the new 
section to begin.

 2. Click the Layout tab.

 3. Click  Breaks.

 4. Click a section break.

23

4

1

>>>Go Further
WORD’S SECTION BREAKS
Word offers four types of section breaks:

 • Next Page—    Starts a new section on a new page

 • Continuous—Starts a new section at the insertion point (does not add a 
page break)

 • Even Page—Starts a new section on the next even numbered page

 • Odd Page—Starts a new section on the next odd numbered page
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Display Text in Columns
If you      put together a brochure, newslet-
ter, or any document where you want 
to mimic the layout of a newspaper 
or magazine, you probably want your 
text to appear in two or more columns. 
When you use columns, as the text in 
the first column reaches the bottom of 
the page, it continues at the top of the 
next column. It’s only when the text 
reaches the bottom of the last column 
that it continues on the next page.

 1. Click where you want to convert 
the text to columns.

Positioning the Insertion 
Point for Columns
If your document has only one 
section and you want to use 
columns for the entire docu-
ment, position the insertion point 
anywhere within the document. 
If your document has multiple 
sections and you want to use 
columns for a single section, posi-
tion the insertion point anywhere 
within that section. If your docu-
ment has multiple sections and 
you want to use columns for the 
entire document, click the entire 
document.

 2. Click the Layout tab.

 3. Click   Columns.

 4. Click More Columns. Word opens 
the Columns dialog.

23

4

1

If you see the column 
preset you want to use, you 
can click it without opening 

the Columns dialog.
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 5. Click the number of columns.

 6. Use these spin boxes to set the 
width of each column.

Applying Unequal Column 
Widths
By default, Word assumes you 
want each column to be the same 
width. To set unique widths for 
each column, you must first deac-
tivate the  Equal Column Width 
check box.

 7. Use these spin boxes to set the 
spacing between each column.

 8. Use the Apply To list to click 
whether you want your new 
column settings applied to the 
whole document or only from the 
insertion point forward.

 9. Click OK.

8 9

5

7

6

>>>Go Further
WORD’S COLUMN PRESETS
Word offers five column presets:

 • One—Reverts the text to a single column

 • Two—Splits the text into two columns of the same width

 • Three—Splits the text into three columns of the same width

 • Left—Splits the text into two columns, with a narrow column on the left 
and a wide column on the right

 • Right—Splits the text into two columns, with a narrow column on the right 
and a wide column on the left
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Adding Footnotes and Endnotes
A footnote       is a short note at the bottom of a page that provides extra infor-
mation about something mentioned in the regular text on that page. Word 
indicates a footnote with a reference mark, a number or other symbol that 
appears as a superscript in both the regular text and in a special footnote box 
at the bottom of the page. An endnote is similar, except that is appears at the 
end of the document.

Word makes working with footnotes and endnotes a breeze. Not only are 
they easy to insert, but Word also keeps track of the reference marks and 
updates the numbers (or whatever) automatically no matter where you insert 
new notes in the document.

Insert a Footnote or Endnote
A default footnote appears at the bottom of the current page and uses Arabic numerals 
(1, 2, 3, and so on) as the reference marks. A default endnote appears at the end of the 
document and uses lowercase Roman numerals (i, ii, iii, and so on) as the reference marks.

3

 1. Position the insertion point where you want the footnote or endnote reference mark 
to appear.

 2. Click the References tab.

 3. Click  Insert Footnote. If you prefer to insert an endnote, click the Insert Endnote com-
mand, instead.

Keyboard Shortcut
You can also  insert a footnote by pressing Command+Option+F. If you want to insert 
an endnote instead, press Command+Option+E .

2

1
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 4. Type your note text.

 5. To navigate footnotes or endnotes, click Next Footnote, and then click whether you 
want to see the next or previous footnote or endnote.

4

5

Word inserts the reference mark 
in the text and in the note area.

>>>Go Further
CREATING CUSTOM FOOTNOTES AND 
ENDNOTES
If Word’s  default footnotes and endnotes are not what you need, the program has 
plenty of options you can wield to customize your notes. For example, you can 
position the footnote area below the last line of the page instead of at the bottom 
of the page; for the reference marks, you can use Arabic numerals, uppercase or 
lowercase letters, uppercase or lowercase Roman numerals, or symbols such as the 
following: *, †, ‡, §. In fact, you can use any symbol available in the Symbol dialog; 
you can start the reference marks at a specific number, letter, or symbol; and you 
can have the reference marks restart with each page or each section.

To create a custom footnote or endnote that uses some or all of these options, 
position the insertion point where you want the reference mark to appear, click 
Insert, and then click Footnotes. Word displays the  Footnote and Endnote dialog. 
Select your options and then click Insert.
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Symbols
+ (addition) operator, 106

, (commas), 101

/ (division) operator, 106

= (equal to) operator, 107

^ (exponentiation) operator, 106

> (greater than) operator, 107

>= (greater than or equal to) operator, 
107

< (less than) operator, 107

<= (less than or equal to) operator, 107

* (multiplication) operator, 106

- (negation) operator, 106

<> (not equal to) operator, 107

() (parentheses), 101

% (percentage) operator, 106

- (subtraction) operator, 106

3-D charts, 147

A
ABS function, 303

Accept All Changes Shown option 
(Word), 281

Accept button (Word), 281

accepting

changes in Excel worksheets, 287

comments in Word documents, 
281-282

Accept or Reject Changes dialog 
(Excel), 287

accessing Preferences, 266

Accounting format, 133

accounts

email accounts

adding automatically, 200-213

adding manually, 201-202

advanced account settings, 202

overview, 199-200

Index
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Index324 accounts

Microsoft accounts

creating, 6-7

signing in to, 5-8

signing out of, 8

user name/initials, 267-268

Accounts window (Outlook), 200-201

ACCRINT function, 299

ACCRINTM function, 299

ACOS function, 303

ACOSH function, 303

ACOT function, 303

ACOTH function, 303

Add Account command (Outlook), 200

addition (+) operator, 106

Add Page command (OneNote), 245

addresses

contact addresses, finding, 238

email addresses, creating for Microsoft 
account, 7

OneDrive addresses, copying links to, 
294

ADDRESS function, 312

Advanced Find and Replace command 
(Word), 64, 66

advancing slides automatically, 196

AGGREGATE function, 303

aligning paragraphs, 27-28

all-day events

compared to appointments, 222-223

defined, 219

scheduling, 223

Always Use These Values Regardless of 
Sign In to Office check box (Preferences), 
268

AMORDEGRC function, 299

AMORLINC function, 299

AND function, 315

Animation gallery, 184

animation (slide shows)

adding, 183-185

applying, 183

guidelines, 180-181

making bullets appear one at a time, 
185

slide transitions, 181-183

application preferences

accessing, 266

keyboard shortcut, 266

Show the Start Screen When This 
Application Starts option, 268-269

user name and initials, 267-268

applications

adding to Dock, 10

switching between, 9

applying. See also formatting

animation, 183

styles, 33

tags, 249-250

user name/initials across accounts, 268

Appointment command (Outlook), 219, 
221

Appointment Recurrence dialog (Outlook), 
221

appointments

compared to all-day events, 222-223

creating, 219-220

defined, 219

recurring appointments

creating, 221-222

deleting, 222

ARABIC function, 303

area charts, 146

AREAS function, 312

arguments (function), 109, 297

arithmetic formulas, 106

ascenders, 25
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325bypassing Start screen at launch

ascending sort order, 117

ASIN function, 303

ASINH function, 303

ATAN function, 304

ATAN2 function, 304

ATANH function, 304

Attach File command (Outlook), 205

attachments

email attachments

adding, 205-206

saving, 210-211

OneNote notebooks, 261-262

audio for slide transitions, 182-183

AutoCorrect, 57-61

autofill (Excel), 126

automatic slide shows, 195-196

AutoRecover, 13

AVEDEV function, 306

AVERAGE function, 306

AVERAGEA function, 306

AVERAGEIF function, 306

AVERAGEIFS function, 306

B
BAHTTEXT function, 314

bar charts, 146

Bar tabs, 62

BASE function, 304

Bcc (blind courtesy copy), 203

BESSELI function, 316

BESSELJ function, 316

BESSELK function, 316

BESSELY function, 317

BETA.DIST function, 306

BETADIST function, 319

BETA.INV function, 306

BETAINV function, 319

BIN2DEC function, 317

BIN2HEX function, 317

BIN2OCT function, 317

Bing Maps, viewing contact addresses in, 
238

BINOM.DIST function, 307

BINOMDIST function, 319

BINOM.DIST.RANGE function, 307

BINOM.INV function, 307

BITAND function, 317

BITLSHIFT function, 317

BITOR function, 317

BITRSHIFT function, 317

BITXOR function, 317

blank documents, creating

at startup, 10-11

from within applications, 11

Blank slide layout, 161

blind courtesy copy (Bcc), 203

blocking email messages, 213

Block Sender command (Outlook), 213

borders, adding to Excel ranges, 140

Borders list (Excel), 140

Breaks command (Word), 93

bubble charts, 146

bulleted lists

adding to slides, 165-166

converting text to, 166

creating, 29-31

making bullets appear one at a time, 
185

Bullets command, 29

bypassing Start screen at launch, 268-269
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Index326 calculation, order of (Excel)

C
calculation, order of (Excel), 108

Calendar

all-day events

compared to appointments, 222-223

defined, 219

scheduling, 223

appointments

compared to all-day events, 222-223

creating, 219-220

defined, 219

recurring appointments, 221-222

Calendar grid, 216

Folder pane, 216

meetings

defined, 219

requesting, 224-225

navigating to dates, 217

overview, 215

switching to, 216

views, 218

work week, configuring, 218

candlestick charts, 147

categories (charts), 144

category axis, 144

CEILING function, 319

CEILING.MATH function, 304

CELL function, 315

cells

Excel cell data, 100-113

confirming data entry, 104

converting to tables, 113

dates and times, 101-103

editing, 105

entering, 104

functions, 109-112

numbers, 100-101

text, 101

OneNote table cells, 247

Word table cells, merging, 82

selecting, 78

Center tabs, 62

Change Chart Type command (Excel), 148

changes

in Excel

accepting/rejecting, 287

tracking, 284-286

in Word

accepting/rejecting, 281-282

navigating, 280

tracking, 278

CHAR function, 314

charts

3-D charts, 147

adding to slides, 168-169

area chart, 146

bar chart, 146

bubble charts, 146

candlestick charts, 147

categories, 144

category axis, 144

changing type of, 148

chart sheets, inserting, 145

chart types, list of, 146-147

column charts, 146

creating, 145

data marker, 144

data marker labels, 156

data series, 144

data values, 144

doughnut charts, 146

embedded charts, 145

formatting elements in, 153

gridlines, 144
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327column charts

layouts, 151

legends, 144, 155

line charts, 146

moving, 149-150

overview, 143

pie charts, 147

plot areas, 144

radar charts, 147

resizing, 150

selecting elements in, 152

styles, 151

surface charts, 147

templates, 149

tick marks, 144

titles, 154

value axis, 144

XY charts, 147

Chart Styles gallery, 151

CHIDIST function, 320

CHIINV function, 320

CHISQ.DIST function, 307

CHISQ.DIST.RT function, 307

CHISQ.INV function, 307

CHISQ.INV.RT function, 307

CHISQ.TEST function, 307

CHITEST function, 320

Choose a File or a Set of Files to Insert 
dialog box (OneNote), 261-262

CHOOSE function, 312

circles, drawing, 40

CLEAN function, 314

Clear Formatting command, 34

clearing

formatting, 34

narration, 189

Click and Type, 57

Click Changes to Accept or Reject dialog 
(Excel), 287

clip art, adding to Word documents, 84

Close command (OneNote), 257

closing OneNote notebooks, 257

CODE function, 314

collaboration

Excel, 282

accepting/rejecting changes, 287

displaying/removing reviewers, 290

editing comments, 283

handling sharing conflicts, 291

hiding comments, 282

inserting comments, 282-283

sharing workbooks, 288-289

tracking changes, 284-286

viewing comments, 283-284

OneDrive

copying link to share, 294

inviting others to share, 293

overview, 291

saving documents to, 292

overview, 275

Word, 275

accepting/rejecting comments and 
changes, 281-282

deleting comments, 277

editing comments, 277

inserting comments, 276

markup display, controlling, 280

markup options, 278-279

navigating comments and changes, 
280

tracking changes, 278

Collapse Ribbon command, 269

collapsing Ribbon, 269

color

color-coding notebook sections, 244

custom colors, 27

text, 26-27

column charts, 146
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Index328 COLUMN function

COLUMN function, 312

columns

Excel range columns

resizing, 138

selecting, 123

Excel table columns

adding, 115-116

deleting, 116-117

selecting, 114

OneNote table columns, 247

selecting, 78

stacked columns, 146

Word document columns, 94

Word table columns, 81

Columns command (Word), 94

Columns dialog (Word), 94

COLUMNS function, 312

Column Width dialog box (Excel), 138

COMBINA function, 304

COMBIN function, 304

commas (,), 101

comments

Excel

editing, 283

hiding, 282

inserting, 282-283

viewing, 283-284

Word

accepting/rejecting, 281-282

deleting, 277

editing, 277

inserting, 276

markup options, 278-284

navigating, 280

comparison formulas, 106-107

Comparison slide layout, 161

compatibility functions, 319-321

COMPLEX function, 317

composing email messages, 203

CONCATENATE function, 314

CONFIDENCE function, 320

CONFIDENCE.NORM function, 307

CONFIDENCE.T function, 307

configuring AutoRecover, 13. See 
also formatting

confirming Excel data entry, 104

conflicts, sharing conflicts, 291

contacts

adding pictures to, 235-236

creating, 228-231

from email messages, 230-231

from scratch, 229

data fields, 229-230

editing, 235

exporting

to Outlook 2011 for Mac, 233

to Outlook for Windows, 232

importing, 231-234

from Outlook 2011 for Mac, 233-234

from Outlook for Windows, 231-233

mapping address of, 238

overview, 227

requesting meetings with, 237-238

sending email to, 237

containers (page), 246-247

Content with Caption slide layout, 161

contiguous ranges, selecting, 123

Continuous section break (Word), 93

CONVERT function, 317

converting

cells to tables, 113

text

to bulleted list, 29, 166

to numbered list, 31

to Word tables, 78

Convert Text to Table dialog (Word), 78
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329data series

Copy command (Excel), 127

copying

formatting, 25

links 

to OneDrive addresses, 294

to OneNote locations, 261

ranges, 127

slides, 163

Copy Link command (OneNote), 260

CORREL function, 307

COS function, 304

COSH function, 304

COT function, 304

COTH function, 304

COUNTA function, 307

COUNTBLANK function, 307

COUNT function, 307

COUNTIF function, 307

COUNTIFS function, 307

COUPDAYBS function, 299

COUPDAYS function, 299

COUPDAYSNC function, 299

COUPNCD function, 299

COUPNUM function, 299

COUPPCD function, 299

COVAR function, 320

COVARIANCE.P function, 307

COVARIANCE.S function, 307

Create a New Section icon (OneNote), 243

Create Table dialog (Excel), 113

CRITBINOM function, 320

CSC function, 304

CSCH function, 304

cube functions, 319

CUBEKPIMEMBER function, 319

CUBEMEMBER function, 319

CUBEMEMBERPROPERTY function, 319

CUBERANKEDMEMBER function, 319

CUBESETCOUNT function, 319

CUBESET function, 319

CUBEVALUE function, 319

CUMIPMT function, 300

CUMPRINC function, 300

Currency format, 133

customization, 265

colors, 27

Developer tab, 272-273

numeric formats, 136

Office theme, 271-272

Preferences

accessing, 266

keyboard shortcut, 266

Show the Start Screen When This 
Application Starts option, 268-269

user name and initials, 267

Ribbon

adding group titles to, 270-271

collapsing, 269

expanding, 270

slide layouts, 176

slide shows, 190-192

table styles, 115

Word footnotes/endnotes, 97

Custom Shows dialog (PowerPoint), 
190-192

Cut command

Excel, 128

PowerPoint, 170

Cycle layout (SmartArt), 43

D
database functions, 312-313

data entry (Excel), 104

data marker, 144

data marker labels, 156

data series, 144
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Index330 data values

data values, 144

Date and Time dialog (Word), 85

date and time functions, 302-303

Date command (OneNote), 259

date filters (Excel), 119

DATE function, 302

dates

adding 

to Excel worksheets, 101-103

to OneNote notebooks, 258-259

to Word documents, 84

date and time formats, 134-136

date and time functions, 302-303

date filters, 119

navigating in Calendar, 217

DATEVALUE function, 302

DAVERAGE function, 313

DAY function, 302

DAYS function, 302

DAYS360 function, 302

Day view (Calendar), 218

DB function, 300

DCOUNT function, 313

DCOUNTA function, 313

DDB function, 300

DEC2BIN function, 317

DEC2HEX function, 317

DEC2OCT function, 317

DECIMAL function, 304

decimal places, controlling in ranges, 137

Decimal tabs, 62

decorative typefaces, 23

Decrease Decimal button (Excel), 137

Define Custom Show dialog (PowerPoint), 
191

DEGREES function, 304

Delete All Comments in Document 
command (Word), 277

Delete Cells command (Excel), 130

Delete command

Excel, 116

Outlook, 212, 222

Word, 56, 83, 277

Delete Slide command (PowerPoint), 173

deleting

email messages, 212

Excel table rows/columns, 116-117

hyperlinks from Word documents, 72

nodes from SmartArt, 45

ranges, 130

recurring appointments, 222

reviewers (Excel), 290

slides, 173

users, 290

Word comments, 277

Word table elements, 82-83

DELTA function, 317

descenders, 25

descending sort order, 117

Developer tab, displaying, 272-273

DEVSQ function, 307

DGET function, 313

dictionary, adding words to, 69

DISC function, 300

Display for Review list (Word), 279

displaying

comments in Excel, 283-284

Developer tab, 272-273

reviewers, 290

weather in Outlook, 217

division (/) operator, 106

DMAX function, 313

DMIN function, 313

Dock, adding applications to, 10

Document dialog (Word), 89, 91
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331email

documents

creating

duplicates, 14

overview, 9-10

at startup, 10-11

from templates, 12

from within applications, 11

formatting. See formatting

graphics. See graphics

OneDrive. See OneDrive

opening, 15

pinning to Recent tab, 16

printing, 16-17

saving, 11-13

uploading to OneDrive, 292

documents (Word). See Word, documents

DOLLAR function, 314

DOLLARDE function, 300

DOLLARFR function, 300

doughnut charts, 146

DPRODUCT function, 313

dragging and dropping email messages, 
211

drawing

circles, 40

lines, 38-39

polygons, 39

squares, 40

Draw Text Box command, 46

DSTDEV function, 313

DSTDEVP function, 313

DSUM function, 313

Duplicate Slide command (PowerPoint), 
163

duplicating

documents, 14

slides, 163

DURATION function, 300

DVAR function, 313

DVARP function, 313

E
EDATE function, 302

Edit Contact Picture command (Outlook), 
235

Edit Hyperlink command (Word), 72

editing

cell data, 105

comments

in Excel, 283

in Word, 277

contacts, 235

custom slide shows, 192

EFFECT function, 300

effects

Picture Effects, 52

Shape Effects, 52

text effects, 33-34

type effects, 25

elements (chart)

data marker labels, 156

formatting, 153

legends, 155

selecting, 152

titles, 154

email

accounts

adding automatically, 200-213

adding manually, 201-202

advanced account settings, 202

overview, 199-200

addresses, creating for Microsoft 
account, 7
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Index332 email

messages

attaching files to, 205-206

Bcc (blind courtesy copy), 203

blocking, 213

composing, 203

creating contacts from, 230-231

deleting, 212

forwarding, 209

junk mail, handling, 213

moving, 211

notifications, 207

reading, 206

recovering deleted messages, 212

replying to, 208

retrieving, 206

saving attachments from, 210-211

sending to contacts, 237

specifying recipients, 204-205

embedded charts, 145

Emphasis animation effects (PowerPoint), 
183

ENCODEURL function, 321

endnotes (Word), 96-97

End Show command (PowerPoint), 189

engineering functions, 316-318

entering Word text

AutoCorrect, 57-58, 60-61

Click and Type, 57

with keyboard, 56-57

symbols, 59-61

Entrance animation effects (PowerPoint), 
183

EOMONTH function, 302

Equal Column Width check box (Word), 95

equal to (=) operator, 107

ERFC function, 317

ERFC.PRECISE function, 317

ERF function, 317

ERF.PRECISE function, 317

ERROR.TYPE function, 315

EVEN function, 304

Even Page section break (Word), 93

events. See all-day events; appointments

EXACT function, 314

Excel Worksheet Function Reference, 295

Excel worksheets

cell data

confirming data entry, 104

dates and times, 101-103

editing, 105

entering, 104

numbers, 100-101

text, 101

changes

accepting/rejecting, 287

tracking, 284-286

charts. See charts

comments

editing, 283

hiding, 282

inserting, 282-283

viewing, 283-284

date and time formats, 134-135

formulas. See formulas

functions. See functions

overview, 99-100

quick filters, 119

ranges. See ranges

reviewers, displaying/removing, 290

sharing, 288-289

sharing conflicts, 291

tables. See tables

text selection, 21

Exit animation effects (PowerPoint), 183

expanding Ribbon, 270

Expand Ribbon command, 270

EXP function, 304
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333font formatting

EXPON.DIST function, 307

EXPONDIST function, 320

exponentiation (^) operator, 106

exporting contacts

to Outlook 2011 for Mac, 233

to Outlook for Windows, 232

F
FACT function, 304

FACTDOUBLE function, 304

FALSE function, 315

F.DIST function, 307

FDIST function, 320

F.DIST.RT function, 307

fields

adding to Word documents, 84

Excel, 112

File Attachment command (OneNote), 261

File menu

New from Template command, 12

Open command, 15

Print command, 16

Save As command, 13-14

files

attaching 

to email messages, 205-206

to OneNote notebooks, 261-262

uploading to OneDrive, 292

Fill command (Excel), 124

filling ranges

with series of values, 125-126

with specific values, 124

Filter and Sort button (Excel), 117, 118

filtering Excel tables, 118-119

filters (Excel), 119

FILTERXML function, 321

financial functions, 298-301

Find and Replace dialog (Word), 64-66

Find feature (Word), 64-65

FIND function, 314

finding

contact addresses, 238

Word text, 64-65

Find Style dialog, 67

Find Whole Words Only check box (Find 
and Replace dialog), 65

F.INV function, 308

FINV function, 320

F.INV.RT function, 308

first-page headers (Word), 85

FISHER function, 308

FISHERINV function, 308

FIXED function, 314

fixed-width typefaces, 23

FLOOR function, 320

FLOOR.MATH function, 304

Folder pane 

Outlook, 216

People, 228

folders

Calendar. See Calendar

Outlook folders

creating, 212

Junk E-mail folder, 213

Font Color list, 26, 27

font formatting, 20

colors, 26-27

type effects, 25

typefaces, 23-24

decorative typefaces, 23

fixed-width typefaces, 23

sans serif typefaces, 23

serif typefaces, 23

setting, 23-24

type size, 24-25
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Index334 footers

footers

content, 83-84

creating, 87-88

Footnote and Endnote dialog (Word), 97

footnotes (Word), 96-97

FORECAST function, 320

FORECAST.CONFINT function, 308

FORECAST.ETS function, 308

FORECAST.ETS.SEASONALITY function, 308

FORECAST.ETS.STAT function, 308

FORECAST.LINEAR function, 308

formatting, 19

chart elements, 153

clearing, 34

copying, 25

Excel tables, 114-115

fonts, 20

overview, 22

text colors, 26-27

type effects, 25

typefaces, 23-24

type size, 24-25

graphics, 51-52

paragraphs, 20

alignment, 27-28

bulleted lists, 29-30

indentation, 32

line spacing, 28-29

numbered lists, 30-34

ranges

borders, 140

controlling number of decimal places, 
137

data formats explained, 133-135

numeric or date formats, 136

resizing columns, 138

resizing rows, 139

wrapping text within, 141

Slide Master, 175

styles, 33

text effects, 33-34

text selection, 20-22

types of formatting, 20

Word tables, 79-80

formulas

arithmetic formulas, 106

building, 107-108

comparison formulas, 106-107

order of calculation, 108

FORMULATEXT function, 312

Forward command (Outlook), 209

Forward Delete command (Word), 56

forwarding email messages, 209

Fraction format, 133

fractions, entering into Excel worksheets, 
101, 134

free-form polygons, drawing, 39

free trial of Office 365, 4

FREQUENCY function, 308

F.TEST function, 308

FTEST function, 320

functions

adding directly to cells, 109-110

adding with Function Wizard, 111-112

arguments, 297

compatibility functions, 319-321

cube functions, 319

database functions, 312-313

date and time functions, 302-303

defined, 296

engineering functions, 316-318

financial functions, 298-301

information functions, 315-316

logical functions, 315

lookup and reference functions, 
311-312
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335gutters (Word)

math and trigonometry functions, 
303-306

overview, 108-109, 295-298

statistical functions, 306-311

syntax, 297

text functions, 313

web functions, 321

Function Wizard, 111-112

FV function, 300

FVSCHEDULE function, 300

G
galleries

Animation, 184

Chart Styles, 151

Picture Quick Styles, 51

Styles, 33, 63

Table Styles, 114

Tags, 250

Transition Styles, 181

WordArt, 45

GAMMA function, 308

GAMMA.DIST function, 308

GAMMADIST function, 320

GAMMA.INV function, 308

GAMMAINV function, 320

GAMMALN function, 308

GAMMALN.PRECISE function, 308

GAUSS function, 308

GCD function, 304

General Preferences

Office theme, 271-272

Show the Start Screen When This 
Application Starts check box, 268-269

GEOMEAN function, 308

GESTEP function, 317

gestures, switching apps with, 9

GETPIVOTDATA function, 312

Go To Date dialog (Outlook), 217

grammar checking Word documents, 
69-70

graphics

adding to Word documents, 84

formatting, 51-52

lassoing, 47

moving, 49

overview, 37

Picture Effects, 52

pictures

formats, 40

inserting, 41-42

linking to, 42

reverting to original, 52

rotating, 50

selecting, 46-47

Shape Effects, 52

shapes, 38-40

circles, 40

inserting, 40

lines, 38-39

overview, 38

polygons, 39

squares, 40

sizing, 48

SmartArt

defined, 41

inserting, 44-45

overview, 43

text boxes, 41, 46

WordArt, 41

greater than (>) operator, 107

greater than or equal to (>=) operator, 107

gridlines, 144

group titles, adding to Ribbon, 270-271

GROWTH function, 308

gutters (Word), 89
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Index336 HARMEAN function

H
HARMEAN function, 308

Header command (Word), 84

headers

content, 83-84

creating, 84-86

headings (Word), 63

HEX2BIN function, 317

HEX2DEC function, 317

HEX2OCT function, 317

Hide Slide command (PowerPoint), 172

hiding

comments in Excel worksheets, 282

slides, 171-173

weather in Outlook, 217

Hierarchy layout (SmartArt), 43

highlighting text, 26

HLOOKUP function, 312

HOUR function, 302

Hyperlink command (Word), 71-72

HYPERLINK function, 312

hyperlinks

adding to OneNote notebooks

links to OneNote locations, 260-261

links to websites, 259-260

adding to Word documents, 71-72

defined, 70

editing in OneNote notebooks, 260

HYPGEOM.DIST function, 308

HYPGEOMDIST function, 320

I
IF function, 315

IFERROR function, 315

IFNA function, 315

IMABS function, 317

images

adding to Word documents, 84

formatting, 51-52

lassoing, 47

moving, 49

overview, 37

Picture Effects, 52

pictures

formats, 40

inserting, 41-42

linking to, 42

reverting to original, 52

rotating, 50

selecting, 46-47

Shape Effects, 52

shapes, 38-40

circles, 40

inserting, 40

lines, 38-39

overview, 38

polygons, 39

squares, 40

sizing, 48

SmartArt

defined, 41

inserting, 44-45

overview, 43

text boxes, 41, 46

WordArt, 41

IMAGINARY function, 317

IMARGUMENT function, 317

IMCONJUGATE function, 318

IMCOS function, 318

IMCOSH function, 318

IMCOT function, 318

IMCSC function, 318

IMCSCH function, 318

IMDIV function, 318

IMEXP function, 318
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337keyboard shortcuts

IMLN function, 318

IMLOG2 function, 318

IMLOG10 function, 318

Import and Export Wizard, 232

Import command (Outlook), 231, 233

importing contacts, 231-234

from Outlook 2011 for Mac, 233-234

from Outlook for Windows, 231-233

IMPOWER function, 318

IMPRODUCT function, 318

IMREAL function, 318

IMSEC function, 318

IMSECH function, 318

IMSIN function, 318

IMSINH function, 318

IMSQRT function, 318

IMSUB function, 318

IMSUM function, 318

IMTAN function, 318

Increase Indent command, 32

Increase List Level command (PowerPoint), 
165

indentation, 32

INDEX function, 312

INDIRECT function, 312

INFO function, 315

information functions, 315-316

Insert Cells command (Excel), 129

Insert Chart command (PowerPoint), 168

Insert dialog box (Excel), 129

Insert Footnote command (Word), 96

Insert Layout command (PowerPoint), 176

Insert Placeholder list (PowerPoint), 176

Insert Table dialog

PowerPoint, 169

Word, 76

Insert to File command, 42

Insert Video dialog (PowerPoint), 166

INTERCEPT function, 308

interface, customizing

Developer tab, 272-273

Office theme, 271-272

Ribbon

adding group titles to, 270-271

collapsing, 269

expanding, 270

INT function, 304

INTRATE function, 300

inviting users to share OneDrive 
documents, 293

IPMT function, 300

IRR function, 300

ISBLANK function, 316

ISERR function, 316

ISERROR function, 316

ISEVEN function, 316

ISFORMULA function, 316

ISLOGICAL function, 316

ISNA function, 316

ISNONTEXT function, 316

ISNUMBER function, 316

ISODD function, 316

ISOWEEKNUM function, 302

ISPMT function, 300

ISREF function, 316

ISTEXT function, 316

J-K
Junk E-mail folder, 213

junk mail, handling, 213

keyboard, navigating slide shows from, 
195

keyboard shortcuts

Appointment command (Outlook), 
220-221

Calendar folder, 216
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Index338 keyboard shortcuts

Calendar views, 218

cell data, editing, 105

Collapse Ribbon command, 269

Copy command, 127

Create a New Section command 
(OneNote), 243

Cut command, 128

Delete command, 212

Expand Ribbon command, 270

Fill command (Excel), 124

Forward command (Outlook), 209

Increase List Level command 
(PowerPoint), 166

Insert Footnote command, 96

Link dialog box (OneNote), 259

New Contact command (Outlook), 229

New Slide command (PowerPoint), 162

OneNote tags, 250

Paste command, 127

People folder, 228

Play From Current Slide command 
(PowerPoint), 193

Play From Start command (PowerPoint), 
193

Preferences dialog, 266

Print dialog, 16

Reply All command (Outlook), 208

Reply command (Outlook), 208

Track Changes (Word), 278

KURT function, 308

L
labels, data marker labels, 156

landscape orientation, 90

LARGE function, 308

lassoing graphics, 47

Layout command (PowerPoint), 171

layouts

charts, 151

slides

custom layouts, 176

overview, 160-161

LCM function, 304

Leader tabs, 62

LEFT function, 314

Left tabs, 62

legends, 144, 155

LEN function, 314

less than (<) operator, 107

less than or equal to (<=) operator, 107

line charts, 146

lines

inserting, 38-39

line spacing, 28-29

Line Spacing command, 28

LINEST function, 309

Link dialog box (OneNote), 259

linking pictures, 42

links

adding to OneNote notebooks

links to OneNote locations, 260-261

links to websites, 259-260

adding to Word documents, 71-72

defined, 70

editing in OneNote notebooks, 260

Link to File command, 42

List layout (SmartArt), 43

list levels (PowerPoint), 164-165

lists

bulleted lists, 29-30

numbered lists, 30-34

LN function, 304

locations, finding, 238

LOG10 function, 304

LOGEST function, 309
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339multiple columns/rows, inserting

LOG function, 304

logical functions, 315

LOGINV function, 320

LOGNORM.DIST function, 309

LOGNORMDIST function, 320

LOGNORM.INV function, 309

Long Date command (Excel), 135

lookup and reference functions, 311-312

LOOKUP function, 312

LOWER function, 314

M
Maps, 238

Margins command (Word), 89

margins (Word), 88-89

markup display, controlling (Word), 
278-280

Markup Options command (Word), 280

Markup Options list (Word), 278-279

Match Case check box (Find and Replace 
dialog), 65

MATCH function, 312

math functions, 303-306

Matrix layout (SmartArt), 43

MAX function, 309

MAXA function, 309

MDETERM function, 304

MDURATION function, 300

MEDIAN function, 309

Meeting command (Outlook), 224, 237

meetings

defined, 219

requesting, 224-225, 237-238

Merge Cells command (Word), 82

merging table cells, 82

messages. See email, messages

Microsoft accounts

creating, 6-7

signing in to, 5-8

signing out of, 8

MID function, 314

MIN function, 309

MINA function, 309

MINUTE function, 302

MINVERSE function, 305

MIRR function, 300

MMULT function, 305

MOD function, 305

MODE function, 320

MODE.MULT function, 309

MODE.SNGL function, 309

Modify Style dialog (Word), 80

monospace typefaces, 23

MONTH function, 302

Month view (Calendar), 218

Move Chart command (Excel), 150

Move Chart dialog box, 150

Move command

OneNote, 245

Outlook, 211

moving

charts, 149-150

containers, 247

email messages, 211

graphics, 49

notebook pages, 245

notebook sections, 244

ranges, 128

MROUND function, 305

MULTINOMIAL function, 305

multiple columns/rows, inserting

into Excel tables, 116

into Word tables, 81
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Index340 multiplication (*) operator

multiplication (*) operator, 106

multitasking, 9

MUNIT function, 305

N
NA function, 316

naming

notebook sections, 243-244

ranges, 131-132

narration

clearing, 189

recording, 188-189

navigating

Calendar, 217

documents (Word)

changes, 280

comments, 280

Navigation pane, 63

slides, 193-195

Navigation pane (Word), 63

negation (-) operator, 106

NEGBINOM.DIST function, 309, 320

NEGBINOMDIST function, 320

NETWORKDAYS function, 302

NETWORKDAYS.INTL function, 302

New Comment command

Excel, 282

Word, 276

New Contact command (Outlook), 229

New Email command (Outlook), 203

New from Template command, 12

New Notebook command (OneNote), 256

New Slide list (PowerPoint), 162

Next Comment command (Word), 280

Next Page section break, 93

N function, 316

nodes, removing from SmartArt, 45

NOMINAL function, 300

noncontiguous ranges, selecting, 123

NORM.DIST function, 309, 320

NORMDIST function, 320

NORM.INV function, 309, 320

NORMINV function, 320

NORM.S.DIST function, 309

NORMSDIST function, 320

NORM.S.INV function, 309

NORMSINV function, 320

notebooks. See OneNote notebooks

not equal to (<>) operator, 107

notes

footnotes/endnotes, 96-97

slide notes, 173-174

Notes page (PowerPoint), 173-174

NOT function, 315

notifications for email messages, 207

NOW function, 302

NPER function, 300

NPV function, 300

numbered lists, 30-34

number filters (Excel), 119

Number format, 133

numbers

entering into Excel worksheets, 100-101

number filters, 119

numbered lists, 30-34

numeric formats, 31, 133, 136

page numbers (Word), 83

NUMBERVALUE function, 314

O
objects. See also graphics

lassoing, 47

moving, 49

rotating, 50
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341orientation of Word pages

selecting, 46-47

sizing, 48

OCT2BIN function, 318

OCT2DEC function, 318

OCT2HEX function, 318

ODDFPRICE function, 300

ODD function, 305

ODDFYIELD function, 300

ODDLPRICE function, 300

ODDLYIELD function, 301

Odd Page section break (Word), 93

Office 365

free trial, 4

Office 365 Home Premium, 4

overview, 3-4

Office theme, setting, 271-272

OFFSET function, 312

OneDrive

documents

copying link to share, 294

inviting others to share, 293

sending an invitation to share, 293

overview, 291

saving documents to, 292

OneNote notebooks

adding data to

dates, 258-259

files, 261-262

links to OneNote locations, 260-261

links to websites, 259-260

closing, 257

creating, 256

location links, copying, 261

overview, 241

pages

containers, 246-247

entering text on, 246

inserting, 245

moving, 245

overview, 245

sections

color-coding, 244

inserting, 243

moving, 244

overview, 242

renaming, 243-244

structure, 255-256

switching between, 257

syncing, 257-258

tables

characteristics of, 247

inserting, 248

tags

applying, 249-250

keyboard shortcuts, 250

overview, 249

To-Do lists, 251-252

Open command, 15

Open & Export command (Outlook), 232

Open in Bing command (Outlook), 238

opening

documents, 15

Print dialog, 16

Open Outlook Contact command 
(Outlook), 230

operators

arithmetic operators, 106

comparison operators, 106-107

optional attendees for meetings, 
specifying, 225

order of calculation (Excel), 108

OR function, 315

Orientation command (Word), 90

orientation of Word pages, 90

9780789754301_BOOK.indb   3419780789754301_BOOK.indb   341 9/17/15   11:11 AM9/17/15   11:11 AM



Index342 Outlook

Outlook

Calendar. See Calendar

email accounts. See email, accounts

email messages. See email, messages

folders

creating, 212

Junk E-mail folder, 213

meetings, requesting with contacts, 
237-238

Outlook 2011 for Mac, importing 
contacts from, 233-234

Outlook for Windows, importing 
contacts from, 231-233

overview, 199

People. See People

weather, showing/hiding, 217

P
Page Break command (Word), 92

page breaks (Word), 92

page layout (Word). See Word documents

page numbers (Word), 83

page orientation (Word), 90

pages

notebook pages

containers, 246-247

entering text on, 246

inserting, 245

moving, 245

overview, 245

Word pages

footers, 87-88

footnotes/endnotes, 96-97

headers, 83-86

page setup, 88-94

tables, 75-83

page setup (Word). See Word, page setup

paper size (Word), 91

paragraph formatting, 20

alignment, 27-28

bulleted lists, 29-30

indentation, 32

line spacing, 28-29

numbered lists, 30-34

parentheses (), 101

Paste command

Excel, 127

PowerPoint, 170

Path Animation animation effects 
(PowerPoint), 183

PDURATION function, 301

PEARSON function, 309

People

contacts

adding pictures to, 235-236

creating, 228-231

data fields, 229-230

editing, 235

exporting to Outlook 2011 for Mac, 
233

exporting to Outlook for Windows, 
232

from scratch, 229

importing from Outlook 2011 for Mac, 
233-234

importing from Outlook for Windows, 
231-233

mapping address of, 238

requesting meeting with, 237-238

sending email to, 237

Folder pane, 228

overview, 227

Reading pane, 228

switching to, 228

Percentage format, 133

percentage (%) operator, 106

percentages, entering into Excel, 101
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343quick filters (Excel)

PERCENTILE function, 320

PERCENTILE.EXC function, 309

PERCENTILE.INC function, 309

PERCENTRANK.EXC function, 309

PERCENTRANK function, 321

PERCENTRANK.INC function, 309

PERMUT function, 309

PERMUTATIONA function, 309

PHI function, 310

photos. See pictures

Picture Effects, 52

Picture layout (SmartArt), 43

Picture Quick Styles gallery, 51

pictures. See also graphics

formats, 40

inserting, 41-42

into contacts, 235-236

into Word documents, 84

linking to, 42

Picture with Caption slide layout, 161

pie charts, 147

PI function, 305

pinning documents to Recent tab, 16

places, finding, 238

Play From Current Slide command 
(PowerPoint), 192

Play From Start command (PowerPoint), 
192

plot areas, 144

PMT function, 301

points, 25

POISSON.DIST function, 310

POISSON function, 321

polygons, drawing, 39

portrait orientation, 90

positioning data labels, 156

POWER function, 305

PowerPoint presentations

overview, 159

slides. See slides

slide shows. See slide shows

PPMT function, 301

Preferences, 266

accessing, 266

keyboard shortcut, 266

Outlook, 207, 218

Show the Start Screen When This 
Application Starts option, 268-269

user name and initials, 267-268

preparing slide shows, 186

recording narration, 188-189

rehearsing slide timings, 187-188

presentations. See Powerpoint 
presentations.

Previous Comment command (Word), 280

PRICE function, 301

PRICEDISC function, 301

PRICEMAT function, 301

Print command, 16

Print dialog, 16

printing documents, 16-17

PROB function, 310

Process layout (SmartArt), 43

PRODUCT function, 305

proofing text (Word), 68-70

PROPER function, 314

PV function, 301

Pyramid layout (SmartArt), 43

Q
QUARTILE function, 321

QUARTILE.EXC function, 310

QUARTILE.INC function, 310

quick filters (Excel), 119
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Index344 Quick Styles

Quick Styles, 51

QUOTIENT function, 305

R
radar charts, 147

RADIANS function, 305

RAND function, 305

RANDBETWEEN function, 305

ranges

copying, 127

deleting, 130

filling

with series of values, 125-126

with specific values, 124

formatting

borders, 140

controlling number of decimal places, 
137

data formats explained, 133-135

numeric or date formats, 136

resizing columns, 138

resizing rows, 139

wrapping text within, 141

inserting, 129

moving, 128

naming, 131-132

overview, 121

selecting

with keyboard, 123

with mouse, 122

RANK function, 321

RANK.AVG function, 310

RANK.EQ function, 310

RATE function, 301

reading email messages, 206

Reading pane (People), 228

rearranging slides, 170

RECEIVED function, 301

recent documents, opening, 15

Recent tab, pinning documents to, 16

recipients (email), specifying, 204-205

recording narration, 188-189

records (Excel), 112

Record Slide Show command (PowerPoint), 
188

recovering deleting email, 212

recurring appointments

creating, 221-222

deleting, 222

reference functions, 311-312

Rehearse Timing command (PowerPoint), 
187

rehearsing slide timings, 187-188

rejecting

changes in Excel worksheets, 287

comments in Word documents, 281-282

Relationship layout (SmartArt), 43

reminders, sending for meetings, 225

Remove Link command (Word), 72

removing. See deleting

Rename command (OneNote), 243

renaming notebook sections, 243-244

Repeat button (PowerPoint), 187

Replace command (Word), 67

REPLACE function, 314

Replace All command (Word), 68

replacing

styles in Word documents, 67

Word text, 66-68

Reply command (Outlook), 208

Reply All command (Outlook), 208

replying to email messages, 208

REPT function, 314

requesting meetings, 224-225, 237-238

Reset Picture command, 52
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345selecting

resizing

charts, 150

columns in ranges, 138

containers, 247

rows in ranges, 139

Resolve Conflicts dialog (Excel), 291

retrieving email messages, 206

reusing slides, 164

reviewers (Excel), displaying/removing, 290

Ribbon

adding group titles to, 270-271

collapsing, 269

expanding, 270

RIGHT function, 314

Right tabs, 62

ROMAN function, 305

rotating graphics, 50

ROUND function, 305

ROUNDDOWN function, 305

ROUNDUP function, 305

ROW function, 312

Row Height dialog box (Excel), 139

rows

Excel range rows

resizing, 139

selecting, 123

Excel table rows

adding, 115-116

deleting, 116-117

selecting, 113

OneNote table rows, 247

Word table rows, 80-81

selecting, 78

ROWS function, 312

RRI function, 301

RSQ function, 310

RTD function, 312

ruler (Word), 77

S
sans serif typefaces, 23

Save As command, 13-14, 210

Save Attachment dialog (Outlook), 210

Save with Document command, 42

saving

documents, 11-13

email attachments, 210-211

scatter charts, 147

scheduling all-day events, 223

Scientific format, 133

scientific notation, 101

Search command (Outlook), 204

SEARCH function, 314

Search People dialog (Outlook), 204

SEC function, 305

SECH function, 305

SECOND function, 302

section breaks (Word), 92-93

Section Color command (OneNote), 244

Section Header slide layout, 161

sections

color-coding, 244

inserting, 243

moving, 244

overview, 242

renaming, 243-244

Select Cell command (Word), 78

Select Column command (Word), 78

selecting

chart elements, 152

container text, 246

Excel table elements, 113-114

graphics, 46-47

ranges

with keyboard, 123

with mouse, 122
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Index346 selecting

slides, 170

table elements, 78

text, 20-22

Select Row command (Word), 78

Select Table command (Word), 78

Send command (Outlook), 203

sending email messages, 203

Send & Receive command (Outlook), 206

serial numbers, date/time, 102

Series dialog box (Excel), 125

SERIESSUM function, 305

serif typefaces, 23

Set Up Show dialog (PowerPoint), 196

shapes, 38-40

circles, 40

inserting, 40

lines, 38-39

overview, 38

polygons, 39

squares, 40

Share Workbook dialog (Excel), 290

sharing workbooks, 288-289

sharing conflicts, 291

SHEET function, 316

SHEETS function, 316

Short Date command (Excel), 135

Show Developer Tab check box 
(Preferences), 273

Show the Start Screen When This 
Application Starts option, 268-269

SIGN function, 305

signing in/out of Microsoft accounts, 5-8

Sign In option, 5-6

Sign Out option, 8

Sign Up command, 6

SIN function, 305

SINH function, 305

sizing

charts, 150

containers, 247

graphics, 48

type size, 24-25

Word pages, 91

SKEW function, 310

SKEW.P function, 310

Slide Master, 174-176

slides

bulleted lists, 165-166

changing layout of, 171

charts, 168-169

copying, 163

deleting, 173

duplicating, 163

hiding, 171-173

inserting, 162

layouts

changing, 171

custom layouts, 176

overview, 160-161

notes, 173-174

overview, 160

rearranging, 170

reusing from another presentation, 164

selecting, 170

Slide Master, 174-176

tables, 169-170

text, 164-165

unhiding, 172

video, 166-167

slide shows

animation

adding, 183-185

guidelines, 180-181

making bullets appear one at a time, 
185

slide transitions, 181-183
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347syntax of functions

automatic slide shows, 195-196

custom slide shows, 190-192

narration

clearing, 189

recording, 188-189

navigating, 193-195

overview, 179

preparing, 186

slide timings, rehearsing, 187-188

sounds, 182

starting, 192-193

slide transitions, 181-183

SLN function, 301

SLOPE function, 310

SMALL function, 310

SmartArt

defined, 41

inserting, 44-45

overview, 43

removing nodes from, 45

SmartArt command, 44

sorting Excel tables, 117

sound for slide transitions, 182-183

spacing, line, 28-29

spam, 213

spell checking Word documents, 69-70

Spelling and Grammar dialog, 69-70

SQRT function, 305

SQRTPI function, 305

squares, drawing, 40

stacked columns, 146

STANDARDIZE function, 310

starting slide shows, 192-193

Start screen, bypassing at launch, 268-269

startup, creating documents at, 10-11

statistical functions, 306-311

STDEVA function, 310

STDEV function, 321

STDEVPA function, 310

STDEV.P function, 310

STDEVP function, 321

STDEV.S function, 310

STEYX function, 310

styles

applying, 33

charts, 151

defined, 20

Picture Quick Styles gallery, 51

replacing in Word documents, 67

table styles, 80

Styles gallery, 33, 63

subbullets, creating, 30

SUBSTITUTE function, 314

SUBTOTAL function, 305

subtraction (-) operator, 106

SUM function, 305

SUMIF function, 305

SUMIFS function, 305

SUMPRODUCT function, 306

SUMSQ function, 306

SUMX2MY2 function, 306

SUMX2PY2 function, 306

SUMXMY2 function, 306

surface charts, 147

switching

between applications, 9

to Calendar folder, 216

between OneNote notebooks, 257

to People, 228

SYD function, 301

Symbol dialog, 59-60

symbols, entering in Word, 59-61

Sync All command (OneNote), 258

Sync command (OneNote), 258

syncing OneNote notebooks, 257-258

syntax of functions, 297
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Index348 Table command (OneNote)

T
Table command (OneNote), 248

Table Design tab (Word), 79-80

tables

adding to slides, 169-170

Excel tables

adding rows/columns to, 115-116

converting cells to, 113

deleting rows/columns from, 116-117

filtering, 118-119

formatting, 114-115

properties, 112

selecting elements in, 113-114

sorting, 117

OneNote tables

characteristics of, 247

inserting, 248

Word tables

converting text to, 78

deleting elements in, 82-83

formatting, 79-80

inserting, 76-78

inserting columns into, 81

inserting rows into, 80-81

merging table cells, 82

overview, 75-76

selecting elements in, 78

Table Styles gallery, 114

tabs (Word), 61-62

Tabs dialog (Word), 62

Tags gallery (OneNote), 250

tags (OneNote)

applying, 249-250

keyboard shortcuts, 250

overview, 249

To-Do lists, 251-252

TAN function, 306

TANH function, 306

TBILLEQ function, 301

TBILLPRICE function, 301

TBILLYIELD function, 301

T.DIST function, 310

TDIST function, 321

T.DIST.2T function, 310

T.DIST.RT function, 310

templates

chart templates, 149

documents templates, 12

overview, 10

text. See also Word documents, text

color, 26-27

converting

to bulleted list, 29, 166

to numbered list, 31

to Word tables, 78

entering

into OneNote notebooks, 246

into Excel worksheets, 101

fonts

overview, 22

type effects, 25

typefaces, 23-24

type size, 24-25

paragraphs

alignment, 27-28

bulleted lists, 29-30

indentation, 32

line spacing, 28-29

numbered lists, 30-34

selecting, 20-22

slide text, 164-165

text effects, 33-34

text filters (Excel), 119

text functions, 313-314
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349User Information (Preferences)

Word text. See Word, text

wrapping in Excel ranges, 141

text boxes, 41, 46

Text Effects command, 34

text filters (Excel), 119

TEXT function, 314

text functions, 313-314

Text Highlight Color list, 26

text wrap in Excel ranges, 141

T function, 314

themes, Office, 271-272

tick marks, 144

time

adding 

into Excel worksheets, 101-103

to Word documents, 84

date and time functions, 302-303

Excel date and time formats, 134-135

Time command (Excel), 135

TIME function, 302

time functions, 302-303

TIMEVALUE function, 302

timings (slide), rehearsing, 187-188

T.INV function, 311

TINV function, 321

T.INV.2T function, 311

Title and Content slide layout, 161

Title and Vertical Text slide layout, 161

Title Only slide layout, 161

titles, chart, 154

Title Slide layout, 161

TODAY function, 302

To-Do lists, 251-252

Track Changes option

Excel, 285

Word, 278

tracking changes

in Excel, 284-286

in Word, 278

transitions (slide), 181-183

Transition Styles (PowerPoint), 181

TRANSPOSE function, 312

TREND function, 311

trigonometry functions, 303-306

TRIM function, 314

TRIMMEAN function, 311

TRUE function, 315

TRUNC function, 306

T.TEST function, 311

TTEST function, 321

Two Content slide layout, 161

type effects, 25

typefaces

decorative typefaces, 23

fixed-width typefaces, 23

sans serif typefaces, 23

serif typefaces, 23

setting, 23-24

TYPE function, 316

type size, changing, 24-25

U
undoing changes, 52

unhiding slides, 172

UNICHAR function, 314

UNICODE function, 314

updating date/time, 85

uploading documents to OneDrive, 292

UPPER function, 314

User Information (Preferences), 267
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Index350 users

users

removing, 290

user name/initials

applying across accounts, 268

changing, 267

Use Wildcards check box (Find and Replace 
dialog), 65

V
value axis, 144

VALUE function, 314

values, filling ranges with

series of values, 125-126

specific values, 124

VAR function, 321

VARA function, 311

VARPA function, 311

VAR.P function, 311

VARP function, 321

VAR.S function, 311

VDB function, 301

Vertical Title and Text slide layout, 161

video, adding to slides, 166-167

viewing

comments in Excel, 283-284

Developer tab, 272-273

reviewers, 290

weather in Outlook, 217

View Notebook Actions icon (OneNote), 
257

views (Calendar), 218

VLOOKUP function, 312

W
weather, showing/hiding in Outlook, 217

web functions, 321

WEBSERVICE function, 321

WEEKDAY function, 303

WEEKNUM function, 303

WEIBULL.DIST function, 311

WEIBULL function, 321

wizards

Function Wizard, 111-112

Import and Export Wizard, 232

WordArt, 41

WordArt gallery, 45

Word documents

changes

accepting/rejecting, 281-282

navigating, 280

tracking, 278

comments

accepting/rejecting, 281-282

deleting, 277

editing, 277

inserting, 276

markup options, 278-279

navigating, 280

footers

content, 83-84

creating, 87-88

footnotes/endnotes, 96-97

headers

content, 83-84

creating, 84-86

hyperlinks

defined, 70

inserting, 71-72

removing, 72
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351ZTEST function

markup display, controlling, 280

navigating, 63

page setup

columns, 94

margins, 88-89

page breaks, 92

page orientation, 90

paper size, 91

section breaks, 92-93

styles, 67

tables

converting text to, 78

deleting elements in, 82-83

formatting, 79-80

inserting, 76-78

inserting columns into, 81

inserting rows into, 80-81

merging table cells, 82

overview, 75-76

selecting elements in, 78

text

AutoCorrect, 57-61

Click and Type, 57

entering with keyboard, 56-57

finding, 64-65

headings, 63

hyperlinks, 70-72

overview, 55

proofing, 68-70

replacing, 66-68

symbols, 59-61

tabs, 61-62

tracking changes, 278

Word Preferences dialog, 57

words, adding to dictionary, 69

WORKDAY function, 303

WORKDAY.INTL function, 303

worksheets. See Excel worksheets

work week, configuring in Calendar, 218

Work Week view (Calendar), 218

wrapping text in Excel ranges, 141

Wrap Text command (Excel), 141

writing email messages, 203

X
XIRR function, 301

XNPV function, 301

XOR function, 315

XY charts, 147

Y-Z
YEAR function, 303

YEARFRAC function, 303

YIELDDISC function, 301

YIELD function, 301

YIELDMAT function, 301

Z.TEST function, 311

ZTEST function, 321
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